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About this guide
This guide provides setup and basic troubleshooting information for the HP Z1 G2 Workstation. It includes
these topics:
Guide topics
Locating HP resources on page 1
HP Z1 G2 Workstation features on page 6
Setting up and using the workstation on page 10
Setting up, backing up, restoring, and recovering Windows 7
on page 27
Setting up, backing up, restoring, and recovering Windows 8
on page 32
Setting up, backing up, restoring, and recovering Windows 10
on page 40
Setting up and restoring Linux on page 49
Updating the workstation on page 55
Diagnostics and minor troubleshooting on page 57
Routine Care on page 63

TIP: If you do not find what you are looking for in this guide:
●

Find technical details in the Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.

●

View removal and replacement videos at http://www.hp.com/go/sml.

●

Go to http://www.hp.com/go/workstations for additional information on your workstation.
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Locating HP resources
This section provides information on the following resources for your HP workstation:
●

Product information

●

Support

●

Product documentation

●

Product diagnostics

●

Product updates

Product information
Topic

Location

Technical specifications

Go to http://www.hp.com/go/quickspecs. In the left pane, select your region and then
select Workstations.

Regulatory, safety and
environmental notices

Refer to the Regulatory, Safety and Environmental Notices for product regulatory
information. You can also refer to the regulatory label on the workstation chassis.

Accessories

For complete and current information on supported accessories and components, go to
http://www.hp.com/go/workstations.

System board

A diagram of the system board is located on the inside of the chassis (all-in-one
configuration). Additional information is located in the workstation Maintenance and
Service Guide on the Web at http://www.hp.com/support/workstation_manuals/.

Serial number, Certificate of
Authenticity (COA), and Genuine
Microsoft® Label (GML) (if
applicable)

The serial number label is on a pull-out card on the side of the display (all-in-one
configuration). The COA (Windows 7) and GML (Windows 8) are typically located near the
serial number label. On some workstations, this label is on the bottom panel.

Product information
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Support
Topic
Product support

Location
For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.
Here you can access the following types of support:

Warranty
information

●

Chat online with an HP technician

●

Obtain email support

●

Find support telephone numbers

●

Locate an HP service center

To locate base warranty information, go to http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, go to http://www.hp.com/go/lookuptool.
To extend a standard product warranty, go to http://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand a
standard product warranty.
You can find your HP Limited Warranty located with the user guides on your product and/or on the CD or DVD
provided in the box. In some countries or regions, HP may provide a printed warranty in the box. For
countries or regions where the warranty is not provided in printed format, you can request a copy from
http://www.hp.com/go/orderdocuments. For products purchased in Asia Pacific, you can write to HP at
Hewlett-Packard, POD, P.O. Box 200
Alexandra Post Office, Singapore 911507
Include your product name, and your name, phone number, and postal address.
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Product documentation
Topic

Location

HP user documentation, white
papers, and third-party
documentation

User documentation is located on your hard drive. On Windows 7, select Start, select HP
Help and Support, and then select HP Documentation. On Windows 8, from the Start
screen, select the app HP Documentation. On Windows 10, select Start, select All Apps,
select HP, and then select HP Documentation. For the latest online documentation, go to
http://www.hp.com/support/workstation_manuals. The documentation incudes this user
guide and the Maintenance and Service Guide.

Removal and replacement videos

To learn how to remove and replace workstation components, go to http://www.hp.com/
go/sml.

Product notifications

Subscriber's Choice is an HP program that allows you to sign up to receive driver and
software alerts, proactive change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at http://www.hp.com/go/subscriberschoice.

Technical specifications

The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include
information about the operating system, power supply, memory, CPU, and many other
system components. To access the QuickSpecs, go to http://www.hp.com/go/quickspecs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Select the desired product.

3.

Under the Knowledge Base heading, use the scroll bar to select Advisories, Bulletins
& Notices.

Product documentation
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Product diagnostics
Topic
Windows diagnostics tools

Location
The UEFI Diagnostics utility is preinstalled on select Windows workstations.
For additional information, see the workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.
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Audible beep and light code
definitions

See the workstation Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.

POST error codes

See the workstation Maintenance and Service Guide at http://www.hp.com/support/
workstation_manuals.
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Product updates
Topic
Driver and BIOS updates

Location
Go to http://www.hp.com/go/workstationsupport to verify that you have the latest drivers
for the workstation.
To determine the current workstation BIOS on your workstation, follow these steps during
system startup:
1.

Turn on the workstation, and press Esc during startup (boot).

2.

Press F10 to enter Computer Setup (F10).

3.

Go to File > System Information. Note the BIOS version and date and compare it
with the BIOS versions that appear on the HP website.

In Windows 7, you can also find the BIOS version number by following these steps:
1.

Go to Start > All Programs > Accessories > System Tools > System Information.

2.

In the right pane, find the line with BIOS Version/Date.

3.

Note the BIOS version and date and compare it with the versions that appear on the
HP website.

In Windows 8, you can also find the BIOS version number by following these steps:

Operating systems

1.

Point to or swipe from the upper-right or lower-right corner of the Start screen to
display the charms.

2.

Select Settings > Change PC Settings.

For information, go to the following locations:
●

Operating systems supported on HP workstations, go to http://www.hp.com/go/
wsos.

●

Windows operating systems, go to http://www.support.microsoft.com.

●

Linux operating systems, go to http://www.linux.com.

Product updates
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HP Z1 G2 Workstation features
The HP Z1 G2 Workstation is offered in both a touch and a non-touch model. The touch model has a glossy
glass front, and the non-touch model has a matte surface, surrounded by a plastic bezel.
For complete and current information on supported accessories and components for the workstation, go to
http://partsurfer.hp.com.

Components
Front and bottom components
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1

Camera angle adjustment dial

5

Serial number pull-out card

2

Camera

6

Speakers

3

Left and right digital microphones

7

Stand

4

Display panel

8

Chassis latches (bottom view)
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Side components

USB 3.0 ports (2)
1

Power button

5

The bottom USB port is also a battery
charging port.

2

Hard drive activity light

6

Headphone jack

3

Slimline tray optical drive (or optional
Thunderbolt module)

7

Microphone jack

4

Memory card reader

Components
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Rear components
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1

Handle

6

Power cord connector

2

Subwoofer jack (orange)

7

USB 2.0 ports (4)

3

Audio line-out jack (green)

8

Optical S/PDIF audio output

4

Audio line-in jack (blue)

9

RJ-45 network connector

5

DisplayPort connector

10

Security cable slot
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Product specifications
Physical characteristics

Weight

With stand (non-touch)

19.2 kg (42.3 lbs)

With stand (touch)

21.0 kg (46.3 lbs)

Without stand (non-touch)

13.3 kg (29.3 lbs)

Without stand (touch)

15.1 kg (33.3 lbs)

Stand only

5.9 kg (13.0 lbs)

Upright, including stand

Height: 533.4 mm (21.0 in)
Width: 660.4 mm (26.0 in)
Depth: 419.1 mm (16.5 in)

Dimensions
Unit only

Height: 457.2 mm (18.0 in)
Width: 660.4 mm (26.0 in)
Depth: 81.3 mm (3.2 in)

Environmental specifications
Operating: 5°C to 35°C (40°F to 95°F)
Temperature

Humidity

Altitude

Non-operating: -40°C to 60°C (-40°F to 140°F)
NOTE: The ambient upper limit of 35°C is good up to 1524 m (5000 ft) elevation. Derate by 1°C for
every 305 m (1000 ft) above 1524 m (5000 ft). For example, at 3,048 m (10,000 ft), the upper
ambient air temperature limit is 30°C.
Operating: 8% to 85% relative humidity, non-condensing
Non-operating: 8% to 90% relative humidity, non-condensing
Operating: 0 to 3,048 m (10,000 ft)
Non-operating: 0 to 9,144 m (30,000 ft)
Operating: ½-sine: 40g, 2-3ms (~62 cm/sec)
Non-operating:

Shock

●

½-sine: 160 cm/s, 2-3ms (~105g)

●

20g, square: 422 cm/s

NOTE:

Values represent individual shock events and do not indicate repetitive shock events.

Operating random: 0.5g (rms), 5-300 Hz, up to 0.0025 g2/Hz
Vibration

Non-operating random: 2.0g (rms), 5-500 Hz, up to 0.0150 g2/Hz
NOTE:

Values do not indicate continuous vibration.

Product specifications
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Setting up and using the workstation
●

Setting up the workstation

●

Using touchscreen gestures

●

Display options

●

Adjusting the audio signal

●

Using the webcam

●

Installing optional components

●

Security

●

Product recycling

Setting up the workstation
Location and ventilation
Proper ventilation for the system is important for workstation operation. To be sure that there is adequate
ventilation:
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●

Operate the workstation on a sturdy, level surface.

●

Provide at least the following clearance:
◦

12 cm (4.7 in) clearance at the front, back, top, and bottom of the workstation

◦

16 cm (6.3 in) clearance on the right side for the optical drive

●

Be sure that the ambient air temperature surrounding the workstation falls within the specified limits
(see Environmental specifications on page 9).

●

Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air intakes.
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Setup procedure
1.

The HP Z1 G2 Workstation weighs 19.2 kg (42.3 lbs) for the non-touch model and 21.0 kg (46.3 lbs) for
the touch model, and must be removed from the box by two people.
WARNING!

If a product is shipped in packaging marked with this icon

, the product must always be

lifted by two people to avoid personal injury due to product weight.
WARNING!

To reduce the risk of electric shock or damage to your equipment:

●

Plug the power cord into an AC outlet that is easily accessible at all times.

●

Disconnect power from the workstation by unplugging the power cord from the AC outlet (not by
unplugging the power cord from the workstation).

●

If your power cord has a 3-pin attachment plug, plug the cord into a grounded (earthed) 3-pin
outlet. Do not disable the power cord grounding pin, for example, by attaching a 2-pin adapter.
The grounding pin is an important safety feature.

For more safety and regulatory information, refer to the Regulatory, Safety and Environmental Notices
located with the user guide on your workstation.
2.

Push the unit down to its lowest horizontal position.
CAUTION: Never open the unit unless it is in the lowest horizontal position. Otherwise, system
components may be damaged.

3.

Slide the latches on the bottom of the workstation outward and open the chassis.

Setting up the workstation
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4.

Insert the USB wireless transceiver in the internal USB port, and close the chassis.

NOTE:

5.
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Keep in mind the following:

●

An outline around the internal USB port identifies the maximum area allowed for an internal USB
device. The USB wireless transceiver must fit within this area.

●

The USB wireless transceiver is in the keyboard box.

●

You can also install the USB wireless transceiver into a side USB port.

●

Be sure that the mouse and keyboard are within 30 cm (12 in) of the workstation and away from
interference from other devices.

Press down on the front of the unit, and then press in on the green button until you hear a click.
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6.

Raise the unit up to its highest horizontal position.

7.

Rotate the monitor to its full vertical upright position (some force is required).

8.

Connect the power cord and peripherals.

IMPORTANT: DO NOT insert the USB wireless transceiver at this location. Refer to steps 3 and 4 for
instructions.

Setting up the workstation
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9.

Connect the workstation to a grounded AC power outlet (1) and turn on the unit (2).

10. Connect the unit to the Internet through the wireless feature or with an RJ-45 network cable.
To set up a WLAN and connect to the Internet, you need a broadband modem (either DSL or cable)
(purchased separately), high-speed Internet service purchased from an Internet service provider, and a
wireless router (purchased separately).

Connecting Bluetooth devices
The workstation is Bluetooth®-enabled. To connect a Bluetooth wireless device:
1.

Make your Bluetooth device send out a radio signal so that it is discoverable by the workstation (refer to
the device documentation for instructions).

2.

In the Windows Control Panel, go to Hardware and Sound then to to Devices and Printers.
●

If your Bluetooth device is a printer, select Add a printer, select Add a network, wireless or
Bluetooth printer, and follow the on-screen instructions.

●

For all other devices, select Add a device, select Bluetooth devices, and then follow the on-screen
instructions.

Disabling Bluetooth devices
The Bluetooth features can be disabled through the system BIOS, through the operating system, or by
removing the wireless modules from the system.
NOTE: Disabling the Bluetooth features through the system BIOS or by removing the wireless modules
from the system will also disable the WLAN functionality.
To disable the Bluetooth features using the system BIOS, do the following:

14

Chapter 3 Setting up and using the workstation

1.

During system boot, press F10 to enter the BIOS setup.

2.

Locate and select the Security menu from the available menu selections displayed near the top of the
screen.

3.

Select Slot Security.

4.

Select Slot 1 mini PCIe / mSATA.

5.

Use the arrow keys to change Enabled to Disabled, and then press F10 to accept the change.

6.

Select File from the header menus, and then select Save Changes and Exit.

To disable the Bluetooth features in Windows 7, do the following:
1.

Change View By from Category to either Large Icon or Small Icon.

2.

In Control Panel, go to Device Manager.

3.

Expand Bluetooth Radios.

4.

Find Intel® Wireless Bluetooth® 4.0 Adapter.

5.

Select Disable.

6.

Select Yes.

7.

To re-enable, select Enable.

To disable the Bluetooth features in Windows 8 or Windows 10, do the following:
1.

Change View By from Category to either Large Icon or Small Icon.

2.

In Control Panel, go to Device Manager.

3.

Expand Bluetooth.

4.

Select Intel® Wireless Bluetooth® 4.0 + HS Adapter to open the menu.

5.

Go to the Driver menu and select Disable.

6.

Select Yes.

7.

To re-enable, select Enable.

To remove the wireless modules, see one of the following for information on removal and replacement of
components:
●

The Maintenance and Service Guide for your workstation at http://www.hp.com/support/
workstation_manuals

●

Videos for your workstation at http://www.hp.com/go/sml

Disabling WLAN
NOTE: The HP Z1 G2 Workstation is WLAN-enabled by default.
NOTE: Disabling the WLAN functionality through the system BIOS or by removing the wireless modules
from the system will also disable the Bluetooth features.
The WLAN can be disabled through the system BIOS, through the operating system, or by removing the
wireless modules from the system.
To disable the WLAN using the system BIOS, do the following:

Setting up the workstation
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1.

During system boot, press F10 to enter the BIOS setup.

2.

Locate and select the Security menu from the available menu selections displayed near the top of the
screen.

3.

Select Slot Security.

4.

Select Slot 1 mini PCIe / mSATA.

5.

Use the arrow keys to change Enabled to Disabled, and then press F10 to accept the change.

6.

Select File from the header menus, and then select Save Changes and Exit.

To disable the WLAN in Windows 7, do the following:
1.

Change View By from Category to either Large Icon or Small Icon.

2.

In Control Panel, go to Device Manager.

3.

Expand Network Adapters.

4.

Select Intel® Dual Band Wireless-AC 7260.

5.

Select Disable.

6.

Select Yes.

7.

To re-enable, select Enable.

To disable the WLAN in Windows 8 or Windows 10, do the following:
1.

Change View By from Category to either Large Icon or Small Icon.

2.

In Control Panel, go to Device Manager.

3.

Expand Network Adapters.

4.

Select Intel® Dual Band Wireless-AC 7260.

5.

Go to Driver menu.

6.

Select Disable.

7.

Select Yes.

8.

To re-enable, select Enable.

To remove the wireless modules, see one of the following for information on removal and replacement of
components:
●

The Maintenance and Service Guide for your workstation at http://www.hp.com/support/
workstation_manuals

●

Videos for your workstation at http://www.hp.com/go/sml

Using touchscreen gestures
A touchscreen workstation allows you to control items on the screen directly with your fingers. To use touch
gestures, you must have a touch model that has Microsoft Windows installed on it.
TIP: On touchscreen workstations, you can perform the gestures on the screen or using the keyboard and
mouse.
NOTE: Not all gestures are supported in all programs. Unless otherwise specified, gestures are supported
in all versions of Windows.
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One-finger slide
The one-finger slide is mostly used to pan or scroll through lists and pages, but you can use it for other
interactions, too, such as moving an object.
●

To scroll across the screen, lightly slide one finger across the screen in the direction you want to move.
NOTE: On Windows 8, when many apps are revealed on the Start screen, you can slide your finger to
move the screen left or right.

●

To drag, press and hold an object, and then drag the object to move it.

Tapping
To make an on-screen selection, use the tap function.
●

Use one finger to tap an object on the screen to make a selection. Double-tap an item to open it.

Using touchscreen gestures
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Scrolling
Scrolling is useful for moving the pointer up, down, left, or right on a page or image.
●

Place two fingers on the screen and then drag them in an up, down, left, or right motion.

Pinching/stretching
Pinching and stretching allows you to zoom out or in on images or text.
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●

Zoom in by placing two fingers together on the display and then move your fingers apart.

●

Zoom out by placing two fingers apart on the display and then move your fingers together.

Chapter 3 Setting up and using the workstation

Rotating (select models only)
Rotating allows you to turn items such as photos.
●

Anchor the forefinger of your left hand on the object you want to rotate. Using your right hand, slide
your forefinger around in a sweeping motion from 12 o’clock to 3 o’clock. To reverse the rotation, move
your forefinger from 3 o’clock to 12 o’clock.

NOTE: Rotate is intended for specific apps where you can manipulate an object or image. Rotate may not be
functional for all apps.

Edge swipes (Windows 8 models only)
With edge swipes you can perform tasks such as changing settings and finding or using apps.

Right-edge swipe
The right-edge swipe reveals the charms, which let you search, share, start apps, access devices, or change
settings.
●

Gently swipe your finger inward from the right edge of the display onto the screen to reveal the charms.

Using touchscreen gestures
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Left-edge swipe
The left-edge swipe reveals your open apps so that you can switch to them quickly.
●

Gently swipe your finger inward from the left edge of the display to switch between apps. Without
lifting your finger, swipe back toward the left edge to reveal all open apps.

Bottom-edge swipe
The bottom-edge swipe allows you to open a list of apps available on your workstation.
▲

From the Windows Start screen, gently swipe your finger from the bottom edge of the display onto the
screen to view available apps.

Tapping
Tap or double-tap an item on the screen as you would click or double-click with an external mouse. Tap and
hold an item to see the context menu.
NOTE: You must tap and hold your finger until a circle appears around the area you are touching, and then
the context menu appears.
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Flicking (Windows 7 models only)
Touch the screen in a light, quick flicking motion up, down, left, or right to navigate through screens or
quickly scroll through documents.
NOTE: For the flick movement to work, a scrollbar must be present in the active window.

Dragging
Press your finger on an item on the screen, and then move your finger to drag the item to a new location. You
can also use this motion to slowly scroll through documents.

Setting touchscreen preferences
1.

To set preferences, perform one of the following:
●

(Windows 7) Go to Control Panel > Hardware and Sound > Pen and Touch.

●

(Windows 8) From the Start screen, select Control Panel, then select Hardware and Sound, then
select Pen and Touch.

These preferences are specific to the touchscreen and the workstation.
2.

To set preferences for left-handed or right-handed users, go to Control Panel, select Hardware and
Sound, then Tablet PC Settings, and then select Other.
These preferences are specific to the touchscreen and the workstation.

Using touchscreen gestures
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Display options
Adjusting display brightness
The HP Z1 G2 Workstation uses two methods to control the display brightness.
●

The backlight brightness settings control the overall brightness of the internal display panel only.

●

The pixel color brightness settings control the individual pixel color intensity for the internal display
panel and an external monitor. Changing the pixel color brightness will affect the color of the pixels and
will affect the colors of your display.

Controlling display panel brightness
Internal display panel backlight brightness
Windows offers two methods for controlling the backlight brightness of the internal display panel. These two
options adjust the backlight brightness from 100% down to 30%.
Windows 7 and Windows 10
1.

Select Control Panel.

2.

Change View By from Category to either Large icons or Small icons.

3.

Select Power Options.

4.

Move the screen brightness slider at the bottom of the window to make adjustments.

5.

At the bottom of the window, select Apply or OK to save the changes.

– or –
1.

Select Start > Programs > Productivity and Tools > HP My Display.

2.

Select Adjust.

3.

Move the slider to make adjustments.

4.

At the bottom of the window, select Apply or OK to save the changes.

Windows 8
1.

Change View By from Category to either Large Icon or Small Icon.

2.

Point to the upper-right of the Start screen to display the charms.

3.

Select Settings.

4.

In the lower-right corner, select Brightness.

5.

Move the slider to make adjustments.

Controlling the brightness of the display panel and an external monitor
Pixel color brightness is controlled with either the Intel® iGFx or the NVIDIA MXM graphics controller interface.
Both controllers can adjust the internal display panel and an external monitor. This adjustment affects the
brightness level of the individual RGB pixels and affects the colors of the pixels.
Intel iGFx adjustments for an internal display panel
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1.

Right-click a blank area on the display desktop to open the system display-control window. Select
Graphics Properties.

2.

Select the Advanced option, and select OK. The Intel Graphics and Media control panel opens.

3.

From the left side of the Intel Graphics and Media control panel, select Display > Color Enhancement.

4.

Open the Display drop-down menu, and then select Built-In Display.

5.

The brightness slider is set to 0%. Move the slider to adjust the brightness up to 100% or down to –60%.

6.

At the bottom of the window, select Apply or OK to save the changes.

Intel iGFx pixel color adjustments for an external monitor
1.

Right-click a blank area on the display desktop to open the system display-control window. Select
Graphics Properties.

2.

Select the Advanced option, and then select OK. The Intel Graphics and Media control panel opens.

3.

From the left side of the control panel, select Display > Color Enhancement.

4.

Open the Display drop-down menu, and then under External Monitor, select the listing for your
monitor. For example, if a ZR2740w monitor is connected, select Digital Display ZR2740w.

5.

The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6.

At the bottom of the window, select Apply or OK to save the changes.

NVIDIA MXM controller pixel color adjustments for an internal display panel
1.

Right-click a blank area on the display desktop to open the system display-control window. Select the
NVIDIA control panel.

2.

Select the HP Z1 G2 display panel icon. A green box outlines the icon.

3.

On the left side of the NVIDIA Control Panel, select Adjust desktop color settings, and select the
internal display panel to adjust the settings.

4.

Select the Use NVIDIA Settings option.

5.

The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6.

At the bottom of the window, select Apply or OK to save the changes.

NVIDIA MXM controller pixel color adjustments for an external monitor
1.

Right-click a blank area on the display desktop to open the system display-control window. Select the
NVIDIA control panel.

2.

Select the icon for your external monitor. A green box outlines the icon.

3.

On the left side of the NVIDIA Control Panel, select Adjust desktop color settings, and select the
external monitor to adjust the settings.

4.

Select the Use NVIDIA Settings option.

5.

The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6.

At the bottom of the window, select Apply or OK to save the changes.

Adding an external monitor
To connect a monitor to the workstation:
1.

Determine the correct cable and/or adapter requirements for the monitor.

Display options

23

Monitor Interface

Required connection

DisplayPort

DisplayPort cable

VGA

DisplayPort to VGA adapter with VGA cable

DVI

DisplayPort to DVI adapter with DVI-D cable

Dual-Link DVI

DisplayPort to DLDVI adapter with Dual-Link cable

HDMI

DisplayPort to HDMI adapter with HDMI cable

2.

Connect the DisplayPort end of the cable/adapter to the DisplayPort connector on the back of the
workstation.

3.

Connect the other end of the cable to the external monitor.

4.

Turn on the monitor. If the workstation is running Windows and a graphics driver is installed, the
workstation automatically detects the external monitor and uses it as a display.

Customizing the display panel or an external monitor
You can manually select or change the monitor refresh rates, screen resolution, color settings, font sizes,
and power management settings of the workstation's display panel or external monitor. Use either the
control panel of the graphics processing unit (MXM card or integrated graphics) or select the Windows
Control Panel > Display options.
For more information about customizing your external monitor, refer to the documentation included with the
monitor.
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Using the HP Z1 G2 Workstation as a monitor
The DisplayPort connector on the HP Z1 G2 Workstation is bi-directional and lets you use the workstation as
a display for another computer, such as a laptop. The other computer (referred to as the external graphics
source) must have a graphics DisplayPort output connector.
A set of keystrokes on the workstation keyboard switches the port from output to input and back. While in
output mode, the port drives an external monitor. While in input mode, an external graphics source drives the
workstation display panel.
NOTE: This feature is described here as supported on the Windows operating system. Similar functionality
is available for some Linux operating systems. The Linux package is available for download at
http://www.hp.com/linux or might be included in the pre-loaded Linux operating system.
To use the workstation as a monitor:
1.

Connect one end of a DisplayPort cable to the external graphics source's DisplayPort connector.
Connect the other end to the DisplayPort connector on the back of the HP Z1 G2 Workstation.

2.

On the HP Z1 G2 Workstation keyboard, simultaneously press Ctrl+Shift+S+D (switch display) to enable
the workstation to display output from the external graphics source.

3.

To switch back, simultaneously press Ctrl+Shift+S+D on the HP Z1 G2 Workstation keyboard to
reinstate the internal graphics source and place the workstation display panel in standby mode. On the
HP Z1 G2 Workstation, move the mouse or press the space bar to wake up the display panel.

NOTE: This feature relies on the My Display utility, which is subject to change with new software and driver
releases. To download the latest software and driver, go to http://www.portrait.com/dtune/hpw/enu/
upgrade_instructions.html.

Display options
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Adjusting the audio signal
●

There is no hardware volume control on the HP Z1 G2 Workstation. (However, some keyboards do have
volume buttons, usually in the upper-right corner.)

●

Volume can be adjusted with the operating system (OS) master control or the software (SW) audio
player control.

●

The OS master control and SW audio player control are independent. However, they are both
simultaneously active and affect the overall volume of the audio signal.

●

If the audio signal is not audible, check the OS master control and SW audio player control to be sure
that neither is set too low.

Using the webcam
The webcam works automatically with any webcam software.
A white activity light is on when the webcam is active. Optimal performance of the fixed-focus lens is at 0.5
meters.
A dial at the top of the workstation lets you perform the following tasks:
●

Adjust the camera angle.

●

Disable the camera by turning the dial all the way toward the front of the workstation. A red stripe in
the camera viewport indicates the lens is pointing straight down into the chassis. The user is not visible.

Installing optional components
You can install additional components such as memory, hard drives, and wireless modules in your
workstation.
●

To view component installation videos, go to http://www.hp.com/go/sml.

●

For installation guidelines and technical information, refer to the Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

Security
You can secure your workstation by attaching a lock to the security cable slot. The workstation includes
several security features to reduce the risk of theft and to warn of chassis intrusion. Refer to the Maintenance
and Service Guide for information about additional hardware and software security features available for
your system.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries.
For information about recycling HP components or products, go to http://www.hp.com/go/recycle.
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Setting up, backing up, restoring, and
recovering Windows 7
This chapter provides setup and update information for the Windows 7 operating system. It includes these
topics:
●

Setting up the Windows 7 operating system

●

Backing up, restoring, and recovering Windows 7

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the operating
system is successfully installed. Adding hardware might cause errors and prevent the operating system from
installing correctly.
NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software updates
are installed on the workstation. See Updating the workstation on page 55.

Setting up the Windows 7 operating system
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the software.
For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the Windows 7 online Help after you successfully install
the operating system.

Installing or upgrading device drivers
You must install the appropriate device drivers before you install hardware devices. Follow the installation
instructions that came with each device. For optimum performance, your operating system must have the
most recent updates, patches, and service packs. See http://www.hp.com for HP-qualified drivers. For
additional driver and software update information, see Updating the workstation on page 55.

Setting up the Windows 7 operating system
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Transferring files and settings
The Windows operating system offers data migration tools that help you select and transfer files and data
from one Windows-based workstation to another.
For information about these tools, go to http://www.microsoft.com.

Backing up, restoring, and recovering Windows 7
Your workstation includes tools provided by HP and Windows to help you safeguard your information and
retrieve it if you ever need to. These tools will help you return your workstation to a proper working state or
even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating backups

●

Restoring and recovering your system

NOTE: For more details about the Windows Backup and Restore tools provided, see Help and Support. To
access Help and Support: select Start, and then select Help and Support.
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the workstation, use Windows tools to create recovery media. In Windows
7, select Start > Control Panel > System and Security > Backup and Restore > Create a system image.

2.

As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows creates a
system restore point for you automatically during a Windows update and during other system
maintenance activities (such as a software update, security scanning, or system diagnostics). You can
also manually create a system restore point at any time. For more information and steps for creating
specific system restore points, see Help and Support. To access Help and Support: select Start, and then
select Help and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal information.
If files are accidentally deleted from the hard drive and they can no longer be restored from the Recycle
Bin, or if files become corrupted, you can restore the files that you backed up. In case of system failure,
you can use the backup files to restore the contents of your workstation. See Backing up your
information on page 28.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Backing up your information
NOTE: Windows includes the User Account Control feature to improve the security of your workstation. You
may be prompted by User Account Control for your permission or password when you perform certain tasks.
To continue a task, select the appropriate option. For information about User Account Control, see Help and
Support: select Start and then select Help and Support.
You should create your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably current
backup. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support: select Start and then select Help and Support.

28

Chapter 4 Setting up, backing up, restoring, and recovering Windows 7

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up your information:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

To create a backup using Windows Backup and Restore:
NOTE: The backup process may take over an hour, depending on file size and the speed of the workstation.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your workstation, use System
Restore to return the workstation to a previous restore point. You can also set restore points manually.
NOTE: Always use this System Restore procedure before you use the System Recovery feature.
To start System Restore:
1.

Close all open programs.

2.

Select Start, select Computer, and then select Properties.

3.

Select System protection > System Restore > Next, and then follow the on-screen instructions.

Backing up, restoring, and recovering Windows 7
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System Recovery
CAUTION: This procedure will delete all user information. To prevent loss of information, be sure to back up
all user information so you can restore it after recovery.
Always use the System Restore procedure before you use the System Recovery program. See System Restore
on page 29.
System Recovery completely erases and reformats the hard disk drive, deleting all data files that you have
created, and then reinstalls the operating system, programs, and drivers. However, you must reinstall any
software that was not installed on the workstation at the factory. This includes software that came on media
included in the workstation accessory box, and any software programs that you have installed.
You can order a recovery media set from support. For U.S. support, go to http://www.hp.com/support. For
worldwide support, go to http://www8.hp.com/us/en/contact-hp/ww-contact-us.html. You can also order
the recovery media set by calling support.
NOTE: Some features might not be available on systems that are shipped without a Windows operating
system.
You must choose one of the following methods to perform a System Recovery:
●

Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. The
recovery image is a file that contains a copy of the original factory-shipped software. To perform a
System Recovery from a recovery image, see System Recovery from a recovery partition image
on page 30.

●

Recovery media — Run System Recovery from recovery media that you have purchased separately.

System Recovery from a recovery partition image
CAUTION: System Recovery deletes all data and programs that you have created or installed.
A Windows system from the HP factory ships with a recovery partition. You can use the recovery partition to
recover the factory operating system.
1.

Turn off the workstation. If necessary, press and hold the power button until the workstation turns off.

2.

Disconnect all peripheral devices from the workstation except the monitor, keyboard, and mouse.

3.

Press the power button to turn on the workstation.

4.

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files... message appears on the screen.

5.

At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6.

When Windows has loaded, shut down the workstation, reconnect all peripheral devices, and then turn
the workstation back on.

Using HP Recovery Disc operating system discs
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the workstation are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as the original drivers. Software that came with the system can be downloaded at
http://www.hp.com.
Use the steps provided in this section if you ordered a Windows 7 operating system DVD and Driver DVD.
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To order a Windows 7 operating system DVD and Driver DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/cgi-bin/hpsupport/index.pl. For worldwide support, go to http://www8.hp.com/us/en/
contact-hp/ww-contact-us.html. You can also order the DVDs by calling support.
To initiate recovery using a Windows 7 operating system DVD:
NOTE: This recovery process takes several minutes.
1.

Backup all personal files.

2.

Restart the workstation, and then insert the Windows 7 operating system DVD into the optical drive.
NOTE: If the workstation does not boot to the DVD, restart the workstation and press Esc as the
workstation is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press enter. Use the arrow keys to select the location where the recovery DVD is inserted to boot from
that device. Booting the DVD from UEFI Boot sources will result in a GPT boot partition. Booting from
Legacy Boot sources will result in an MBR boot partition.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the operating system installation has completed:
1.

Eject the Windows 7 operating system DVD, and insert the Driver DVD once the system is booted into
the OS for the first time.
NOTE:

The Driver DVD will load prerequisite software, and then allow you to load drivers.

2.

Install the Hardware Enabling Drivers. HP recommends installing all available drivers.

3.

You can download applications that came with the workstation at http://www.hp.com.

NOTE: For more information on using the restore media, refer to the white paper “Restoring Windows 7 on
the HP Z420, Z620 and Z820: Using HP OS DVD and Driver DVD.” This white paper can be found on
http://www.hp.com/support.

Backing up, restoring, and recovering Windows 7
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5

Setting up, backing up, restoring, and
recovering Windows 8
This chapter provides setup and update information for the Windows 8 operating system. It includes these
topics:
●

Supplementary information

●

Setting up the Windows 8 operating system

●

Downloading Windows 8 updates

●

Backing up, restoring, and recovering Windows 8

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the operating
system is successfully installed. Adding hardware might cause errors and prevent the operating system from
installing correctly.
NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software updates
are installed on the workstation. Refer to the chapter on updating the workstation.

Supplementary information
Additional information is available in Help and Support after you customize the operating system. To learn
more about Windows 8, review the Windows Basics guide included with your workstation. The guide provides
information on common tasks using the touchscreen or the keyboard.

Setting up the Windows 8 operating system
The first time you turn on the workstation you can customize the operating system. When you are connected
to the Internet, Microsoft activates your operating system. This process takes about 15 to 30 minutes.
Carefully read and follow the instructions on the screen.
We recommend that you register your workstation with HP, so you can receive important software updates,
request support, and sign up for special offers.
CAUTION: After the initial setup process has begun, DO NOT TURN OFF THE WORKSTATION UNTIL THE
PROCESS IS COMPLETE. Turning off the workstation during this process may damage the software that runs
the workstation or prevent its proper installation.
NOTE: Windows includes the User Account Control feature to improve the security of your workstation. You
may be prompted by User Account Control for your permission or password when you perform certain tasks.
To continue a task, select the appropriate option. For information about User Account Control, see Help and
Support: from the Start screen type help and then select Help and Support.
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Downloading Windows 8 updates
Microsoft may release updates to the operating system. To help keep the workstation running optimally, HP
recommends checking for the latest updates during the initial installation and periodically throughout the life
of the workstation.
Run Windows Update as soon as possible after you set up your workstation.
1.

Point to the upper-right or lower-right corner of the Start screen to display the charms.

2.

Select Settings > Change PC Settings > Update and Recovery > Windows Update.

Backing up, restoring, and recovering Windows 8
Your workstation includes tools provided by HP and Windows to help you safeguard your information and
retrieve it if you ever need to. These tools will help you return your workstation to a proper working state or
even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

NOTE: For more details about the tools provided, see Help and Support. From the Start screen, type help,
and then select Help and Support.
HP recommends that you print the recovery procedures and save them for later use, in case of system
instability.

Backing up your information
NOTE: Windows includes the User Account Control feature to improve the security of your workstation. You
may be prompted by User Account Control for your permission or password when you perform certain tasks.
To continue a task, select the appropriate option. For information about User Account Control, from the Start
screen type help and then select Help and Support.
Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and data files,
you should continue to back up your system on a regular basis to maintain a reasonably current backup. The
system repair media is used to start up (boot) the workstation and repair the operating system in case of
system instability or failure. Your initial and subsequent backups allow you to restore your data and settings
if a failure occurs.
NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support: from the Start screen, type help and then select Help and
Support.
From the Start screen, type backup, and then select Save backup copies of your files with File History.
You can back up your information to an optional external hard drive or a network drive.
Note the following when you perform a backup:

Downloading Windows 8 updates
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●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Windows Backup and Restore:
NOTE: The backup process may take more than an hour, depending on file size and the speed of the
workstation.
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1.

From the Start screen, type backup, and then select from the list of displayed options.

2.

Follow the on-screen instructions to set up your backup, create a system image, or create system repair
media.
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Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
CAUTION: Use a flash drive with a capacity of at least 8 GB. Any information on the USB flash drive will be
erased before the recovery media is created.
1.

After you successfully set up the workstation, create recovery media. This step creates a backup of the
recovery partition on the workstation. The backup can be used to reinstall the original operating system
in cases where the hard drive is corrupted or has been replaced.
You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot a
Windows 8 workstation that is unable to start. The USB flash drive can be used to reinstall the original
operating system and the programs that were installed at the factory.
CAUTION: If you select Copy contents from the recovery partition to the recovery drive, you will
have the option to delete the recovery partition when the Recovery Media creation is finished. On most
systems, this partition is 10 GB in size. HP recommends that you not delete this recovery partition. If the
partition is deleted, you will be unable to restore the Windows 8 factory recovery partition to the hard
drive using the recovery USB drive. You can free up drive space by deleting the recovery partition, but
you won't be able to refresh or reset the PC again.
To create the recovery media, from the Start screen, type create a recovery drive, and then
select Create a recovery drive. Follow the on-screen instructions to continue.

2.

As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows automatically
creates a system restore point for you during a Windows update and during other system maintenance
activities (such as a software update, security scanning, or system diagnostics). You can also manually
create a system restore point at any time. For more information and steps for creating specific system
restore points, see Windows Help and Support. From the Start screen, type help, and then select Help
and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal information.
Windows File History can be set to regularly and automatically back up files from libraries, desktop,
contacts, and favorites. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can use File History to restore the files
that you backed up. Restoring files is also useful if you ever choose to reset the workstation by
reinstalling Windows.
NOTE:

File History is not enabled by default, so you must turn it on.

For more information and steps for enabling Windows File History, see Windows Help and Support.
From the Start screen, type help, and then select Help and Support.

Restoring and recovering using Windows 8 tools
Windows recovery tools provide access to several options for recovering your system. Choose the method
that best matches your situation and level of expertise:

Backing up, restoring, and recovering Windows 8
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●

If you need to restore your personal files and data, you can use Windows File History to restore your
information from the backups you created. For more information and steps for using File History, see
Windows Help and Support. From the Start screen, type help, and then select Help and Support.

●

If you want to restore the system to a previous state without losing any personal information, Windows
System Restore is an option. System Restore allows you to restore without the requirements of
Windows Refresh or a reinstallation. Windows creates system restore points automatically during a
Windows update and other system maintenance events. Even if you did not manually create a restore
point, you can choose to restore to an automatically created restore point. For more information and
steps for using Windows System Restore, see Windows Help and Support. From the Start screen, type
help, and then select Help and Support.

●

If you want a quick and easy way to recover the system without losing your personal information,
settings, or the apps that came preinstalled on your workstation or were purchased from the Windows
Store, Windows Refresh is an option. This method does not require backing up data to another drive.
See Using Windows 8 Refresh on page 36.

●

If you want to reset your workstation to its original state, Windows Reset provides an easy way to
remove all personal data, apps, and settings, and reinstall Windows. The Reset recovery tool reinstalls
the operating system and HP programs and drivers that were installed at the factory. Software not
installed at the factory must be reinstalled. Any personal files must be restored from backups you
made. See Using Windows 8 Reset on page 37.

●

If the workstation is unable to start, you can use the Windows recovery USB flash drive you created to
recover the system. See Recovery using the Windows 8 recovery USB flash drive on page 38.

●

If the workstation is unable to start and you did not create a recovery USB flash drive or the one you
created does not work, see Recovery using Windows 8 restore media on page 39.

Using Windows 8 Refresh
IMPORTANT: Refresh removes any traditional applications that were not originally installed on the system
at the factory.
NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support: from the Start screen type help, and then select Help and Support.
If Windows is responding, use these steps to start Refresh:
NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a quick way
to see what you might need to reinstall. See Help and Support for instructions on reinstalling traditional
applications. From the Start screen, type help, and then select Help and Support.
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2.

Select Settings.

3.

Select Change PC settings in the bottom-right corner of the screen, and then select Update and
Recovery > Recovery from the PC settings screen.

4.

Under Refresh your PC without affecting your files, select Get started, and follow the on-screen
instructions.

If Windows is not responding, use these steps to start Refresh:
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1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: from the Start screen, type This PC,
and then select This PC.
NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media that you created. See Recovery using the Windows 8 recovery USB flash drive
on page 38. If you did not create recovery media, you must use the Windows 8 restore media
(available separately). See Recovery using Windows 8 restore media on page 39.

3.

If the HP Recovery partition is listed, restart the workstation, and then press esc while the company
logo is displayed. The workstation Startup Menu opens.

4.

Press f11 to select the System Recovery option.

5.

Choose your keyboard layout.

6.

Select Troubleshoot.

7.

Select Refresh.

8.

Follow the on-screen instructions to continue.

Using Windows 8 Reset
IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you want to retain.
If Windows is responding, use these steps to start Reset:
NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support: from the Start screen type help, and then select Help and Support.
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2.

Select Settings.

3.

Select Change PC settings in the bottom-right corner of the screen, select Update and Recovery then
select Recovery

4.

Under Remove everything and reinstall Windows, select Get started, and follow the on-screen
instructions.

If Windows is not responding, use these steps to start Reset:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: from the Start screen, type This PC,
and then select This PC.
NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media that you created. See Recovery using the Windows 8 recovery USB flash drive
on page 38. If you did not create recovery media, you must use the Windows 8 restore media
(available separately). See Recovery using Windows 8 restore media on page 39.

3.

If the HP Recovery partition is listed, restart the workstation, and then press esc while the company
logo is displayed. The workstation Startup Menu opens.

4.

Press f11 to select the System Recovery option.

5.

Choose your keyboard layout.
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6.

Select Troubleshoot.

7.

Select Reset.

8.

Follow the on-screen instructions to continue.

Recovery using the Windows 8 recovery USB flash drive
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you
have created and any software that you have installed on the workstation are permanently removed. The f11
recovery tool reinstalls the operating system and the HP programs and drivers that were installed at the
factory. You must reinstall all other software.
To recover your system using the recovery USB flash drive you previously created:
NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see Recovery
using Windows 8 restore media on page 39.
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1.

If possible, back up all personal files.

2.

Insert the recovery USB flash drive into a USB port on your workstation.

3.

Restart the workstation and as soon as you see the HP logo screen, press f9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press enter.

4.

Choose your keyboard layout.

5.

Select Troubleshoot.

6.

Select Refresh your PC.

7.

Follow the on-screen instructions.
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Recovery using Windows 8 restore media
This recovery process requires Windows 8 restore discs, which can be ordered from the support website. The
Windows 8 restore media consists of a Windows 8 operating system disc and a Windows 8 driver disc.
For U.S. support, go to http://www.hp.com/support. For worldwide support, go to http://www8.hp.com/us/
en/contact-hp/ww-contact-us.html. You can also order the media by calling support.
CAUTION: Using the Windows 8 operating system disc completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the workstation are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.
Begin recovery using the Windows 8 operating system disc:
NOTE: It can take several minutes to load the operating system disc.
1.

Back up all personal files.

2.

Restart the workstation, and then follow the instructions provided with the Windows 8 operating
system disc to install the operating system.

3.

When prompted, press any keyboard key.
NOTE: If the workstation does not boot to the DVD, restart the workstation and press esc as the
workstation is starting to see the Startup menu. Use the arrow keys to select the boot menu, and then
press enter. Use the arrow keys to select the location where the recovery DVD is inserted to boot from
that device. Booting the DVD from UEFI Boot sources will result in a GPT boot partition. Booting from
Legacy Boot sources will result in an MBR boot partition. It is recommended that you boot Windows 8
from UEFI Boot sources to take full advantage of the features available in Windows 8.

4.

Follow the on-screen instructions.

After the repair is completed and the Windows 8 desktop appears:
1.

Remove the Windows 8 operating system disc, and then insert the driver disc.
NOTE: The driver disc will load prerequisite software, and then allow you to load drivers and
applications.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

3.

Install Recommended Applications of your choice. Only applications that are not available for download
from http://www.hp.com are included on the driver disc.

Backing up, restoring, and recovering Windows 8
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Setting up, backing up, restoring, and
recovering Windows 10
This chapter provides setup and update information for the Windows 10 operating system. It includes these
topics:
●

Activating and customizing the software

●

Turning off the workstation

●

Finding more information

●

If you encounter issues

Activating and customizing the software
Additional information is available in online help after you activate the operating system.
NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to permit
the required airflow.

Initial Windows operating system setup
The first time you turn on the workstation, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to complete the
initial Windows setup.
We recommend that you register your workstation with HP during operating system set up so you can receive
important software updates, facilitate support questions, and sign up for special offers.
CAUTION: After the setup process has begun, DO NOT TURN OFF THE WORKSTATION UNTIL THE PROCESS IS
COMPLETE. Turning off the workstation during the setup process may damage the software that runs the
workstation or prevent its proper installation.

Customizing the monitor display
If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font sizes,
and power management settings.
For more information, see the online documentation provided with the graphics controller utility or the
documentation that came with your monitor.
▲

Right-click on the Windows desktop, then click Personalize or Screen resolution to change display
settings.
– or –
Click the Start icon, click Settings, and the click Personalization.

Turning off the workstation
To properly turn off the workstation, shut down the operating system software.
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▲

Click the Start icon, click the Power icon, and then select Shut down.
– or –
From the taskbar, type settings, select Settings, type shut, and then click Turn off your PC.

Finding more information
NOTE: Some or all of the following documents are available on the workstation hard drive.
●

Getting Started—Helps you connect the workstation and peripheral devices and set up factory-provided
software; also includes basic troubleshooting information should you encounter any problems during
initial startup.

●

Hardware Reference Guide—Provides an overview of the product hardware, as well as instructions for
upgrading this series of workstation; includes information on RTC batteries, memory, and power supply.

●

Maintenance and Service Guide (English only)—Provides information on parts removal and replacement,
troubleshooting, Desktop Management, setup utilities, safety, routine care, connector pin assignments,
POST error messages, diagnostic indicator lights and error codes.

●

Regulatory, Safety and Environmental Notices—Provides safety and regulatory information that
ensures compliance with U.S., Canadian, and various international regulations.

If you encounter issues
There are several means to diagnose and resolve potential issues. HP provides several proprietary
diagnostics tools but recommends a sequential troubleshooting approach that addresses the most basic root
cause to the more complex. Steps include:
●

Visual inspection

●

Blink or beep codes

●

HP PC Hardware Diagnostics

●

HP Support

●

System restore

●

System recovery

Performing basic troubleshooting
You can find troubleshooting information in the comprehensive Maintenance and Service Guide (English only)
available under the reference library at http://www.hp.com/support. Select your country and language,
select Product Support & Troubleshooting, enter the model number of the workstation, and click Search.

Visual inspection: No boot, no power, no video
If you encounter problems with the workstation, monitor, or software, see the following list of general
suggestions before taking further action:
●

Check that the workstation and monitor are plugged into a working electrical outlet.

●

Check to see that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

●

Check to see that the workstation is turned on and the power light is on.

Finding more information
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●

Check to see that the monitor is turned on and the monitor light is on.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

If the system does not boot, press and hold any key. If the system beeps, then the keyboard is operating
correctly.

●

Check all cable connections for loose connections or incorrect connections.

●

Wake the workstation by pressing any key on the keyboard or pressing the power button. If the system
remains in sleep mode, shut down the workstation by pressing and holding the power button for at
least four seconds. Then press the power button again to restart the workstation. If the system will not
shut down, unplug the power cord, wait a few seconds, and then plug it in again. The workstation will
restart if automatic start on power loss is set in Computer Setup. If the workstation does not restart,
press the power button.

●

Reconfigure your workstation after installing a non-Plug and Play expansion board or other option.

●

Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that printer model.

●

Remove any bootable media (CD/DVD or USB device) from the system before turning it on.

●

If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

●

If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be connected to the monitor port
on the source that is set as the primary video source. During boot, the other video ports are disabled
and if the monitor is connected to one of these ports, the monitor will not function. You can select or
change the primary video source in Computer Setup.

CAUTION: When the workstation is plugged into an AC power source, there is always voltage applied to the
system board. To reduce the risk of system board or component damage, always disconnect the power cord
from the power source before opening the workstation.

Blink or beep codes: Interpreting POST diagnostic front panel LEDs and audible codes
If you see flashing LEDs on the front of the workstation or if you hear beeps, see the Maintenance and Service
Guide (English only) for interpretation and recommended action.

Using HP PC Hardware Diagnostics
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite the
support process when issues are found. The tools save time by pinpointing the component that needs to be
replaced.
●

Isolate true hardware failures: The diagnostics run outside of the operating system so they effectively
isolate hardware failures from issues that may be caused by the operating system or other software
components.

●

Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID is
generated. This ID can then be provided to the call agent, who will either schedule support or provide
replacement parts.

How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health of the
workstation.
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1.

Turn on the workstation and press Esc repeatedly until the BIOS Boot Menu appears.

2.

Press F2 or select Diagnostics (F2).
Pressing F2 signals the system to search for the diagnostics in the follow sequence:
a.

A connected USB drive

b.

The hard disk drive

c.

A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if
the USB or hard disk drive versions are not detected

Downloading HP PC Hardware Diagnostics to a USB device
NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.
There are two options to download HP PC Hardware Diagnostics to a USB device:
Option 1: HP PC Diagnostics homepage— Provides access to the latest UEFI version
1.

Go to http://hp.com/go/techcenter/pcdiags.

2.

Click the UEFI Download link, and then select Run.

Option 2: Support and Drivers pages—Provide downloads for a specific product for earlier and later
versions
1.

Go to http://www.hp.com.

2.

Point to Support, located at the top of the page, and then click Download Drivers.

3.

In the text box, enter the product name, and then click Go.
– or –
Click Find Now to let HP automatically detect your product.

4.

Select your workstation model, and then select your operating system.

5.

In the Diagnostic section, click HP UEFI Support Environment.
– or –
Click Download, and then select Run.

Before you call for technical support
WARNING! When the workstation is plugged into an AC power source, voltage is always applied to the
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet and allow the internal system components to cool before you
touch them.
If you are having problems with the workstation, try the appropriate solutions as described in the previous
sections and summarized below to try to isolate the exact problem before calling for technical support.
●

Check the power LED on the front of the workstation to see if it is flashing and listen for a series of
beeps emanating from the workstation. The flashing lights and/or beeps are error codes that will help
you diagnose the problem. See the Maintenance and Service Guide (English only) for details.

●

If the screen is blank, plug the monitor into a different video port on the workstation if one is available.
Or, replace the monitor with a monitor that you know is functioning properly.

●

If you are working on a network:

If you encounter issues
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◦

Use a different network cable to connect your workstation to the network.

◦

Connect a different workstation with a different cable to the network.

If your problem is not resolved, the network jack on your workstation or the network wall jack might be
faulty.
●

If you recently added new hardware, remove the hardware.

●

If you recently installed new software, uninstall the software.

●

Comprehensive online technical support is also available at http://www.hp.com/support.

●

If the workstation will turn on but will not boot into the operating system, you may run the “pre-boot”
diagnostics utility, HP PC Hardware Diagnostics.

●

If the workstation will boot into the operating system, there are two possible tools that provide selfsolve diagnostics and online chat features (if internet access is also available).
◦

If you have HP Support Assistant, you may access it from the Start screen by clicking the HP
Support Assistant app, clicking My computer, and then clicking Diagnostics.

◦

If you do not have HP Support Assistant installed, you may access HP Instant Support Professional
Edition at http://www.hp.com/go/ispe.

You may also access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest
online support information, software and drivers, for proactive notification, and access to a worldwide
community of peers and HP experts.
Comprehensive online technical support is also available at http://www.hp.com/support.
If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:
●

Be in front of your workstation when you call.

●

Before calling, write down the product ID number, workstation and monitor serial numbers, and the
failure ID produced by running the diagnostics if applicable.

●

Spend time troubleshooting the problem with the service technician.

●

Remove any hardware that was recently added to your system.

●

Remove any software that was recently installed.

NOTE: For sales information and warranty upgrades (HP Care Packs), call your local authorized service
provider or dealer.

Backing up, restoring, and recovering in Windows 10
This section provides information about the following processes. The information in the section is standard
procedure for most products.
●

Creating recovery media and backups

●

Restoring and recovering your system

For additional information, see Help and Support.
▲
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Creating recovery media and backups
The following methods of creating recovery media and backups are available on select products only. Choose
the available method according to your workstation model.
●

Use HP Recovery Manager to create HP Recovery media after you successfully set up the workstation.
This step creates a backup of the HP Recovery partition on the workstation. The backup can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been replaced.
For information on creating recovery media, see Creating HP Recovery media (select products only)
on page 45. For information on the recovery options that are available using the recovery media, see
Using Windows tools on page 46.

●

Use Windows tools to create system restore points and create backups of personal information.
For more information, see Recovering using HP Recovery Manager on page 47.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.
Creating HP Recovery media (select products only)
If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu,
select File Explorer.
●

If your workstation does not list the Windows partition and the Recovery partition, you can obtain
recovery media for your system from support. See the Worldwide Telephone Numbers booklet included
with the workstation. You can also find contact information on the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can use Windows tools to create system restore points and create backups of personal information,
see Using Windows tools on page 46.

●

If your workstation does list the Recovery partition and the Windows partition, you can use HP Recovery
Manager to create recovery media after you successfully set up the workstation. HP Recovery media
can be used to perform system recovery if the hard drive becomes corrupted. System recovery
reinstalls the original operating system and software programs that were installed at the factory and
then configures the settings for the programs. HP Recovery media can also be used to customize the
system or restore the factory image if you replace the hard drive.
◦

Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

◦

HP Recovery Manager examines the workstation and determines the required storage capacity for
the media that will be required.

◦

To create recovery discs, your workstation must have an optical drive with DVD writer capability,
and you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a
high-quality blank USB flash drive.

◦

If your workstation does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs. If you use an external optical drive, it must be connected
directly to a USB port on the workstation; the drive cannot be connected to a USB port on an
external device, such as a USB hub. If you cannot create DVD media yourself, you can obtain
recovery discs for your workstation from HP. See the Worldwide Telephone Numbers booklet
included with the workstation. You can also find contact information on the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

If you encounter issues
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◦

Be sure that the workstation is connected to AC power before you begin creating the recovery
media.

◦

The creation process can take an hour or more. Do not interrupt the creation process.

◦

If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue.

To create HP Recovery media:
1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

If prompted, click Yes to allow the program to continue.

3.

Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 47.
Using Windows tools
You can create recovery media, system restore points, and backups of personal information using Windows
tools.
NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.
For more information and steps, see Help and Support.
▲

Type help in the taskbar search box, and then select Help and Support.

Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:
IMPORTANT: Not all methods are available on all products.
●

Windows offers several options for restoring from backup, refreshing the workstation, and resetting
the workstation to its original state. For more information see Help and Support.
▲

●

Type help in the taskbar search box, and then select Help and Support.

If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/
or applications option (select products only) of HP Recovery Manager to reinstall the individual
application or driver.
▲

Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers
and/or applications, and then follow the on-screen instructions.

●

If you want to recover the Windows partition to original factory content, you can choose the System
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media.
For more information, see Recovering using HP Recovery Manager on page 47. If you have not already
created recovery media, see Creating HP Recovery media (select products only) on page 45.

●

On select products, if you want to recover the workstation’s original factory partition and content, or if
you have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more
information, see Recovering using HP Recovery Manager on page 47.

●

On select products, if you want to remove the recovery partition to reclaim hard drive space, HP
Recovery Manager offers the Remove Recovery Partition option.
For more information, see Removing the HP Recovery partition (select products only) on page 48.

46

Chapter 6 Setting up, backing up, restoring, and recovering Windows 10

Recovering using HP Recovery Manager
HP Recovery Manager software allows you to recover the workstation to its original factory state by using
the HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only). If you have not already created recovery media, see Creating HP Recovery
media (select products only) on page 45.
What you need to know before you get started
●

HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this workstation, you must either download the software from the manufacturer's
website or reinstall the software from the media provided by the manufacturer.
IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct
workstation issues.

●

HP Recovery media must be used if the workstation hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media (select products only) on page 45.

●

To use the Factory Reset option (select products only), you must use HP Recovery media. If you have
not already created recovery media, see Creating HP Recovery media (select products only) on page 45.

●

If your workstation does not allow the creation of HP Recovery media or if the HP Recovery media does
not work, you can obtain recovery media for your system from support. See the Worldwide Telephone
Numbers booklet included with the workstation. You can also find contact information from the HP
website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you want to retain.
Using HP Recovery media, you can choose from one of the following recovery options:
NOTE: Only the options available for your workstation display when you start the recovery process.
●

System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

●

Factory Reset—Restores the workstation to its original factory state by deleting all information from
the hard drive and re-creating the partitions. Then it reinstalls the operating system and the software
that was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.
Using the HP Recovery partition (select products only)
The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.
To start HP Recovery Manager from the HP Recovery partition:
1.

Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery
Environment.
- or Press f11 while the workstation boots, or press and hold f11 as you press the power button.

2.

Select Troubleshoot from the boot options menu.

3.

Select Recovery Manager, select System Recovery, and then follow the on-screen instructions.

If you encounter issues
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Using HP Recovery media to recover
You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.
1.

If possible, back up all personal files.

2.

Insert the HP Recovery media, and then restart the workstation.
NOTE: If the workstation does not automatically restart in HP Recovery Manager, change the
workstation boot order. See Changing the workstation boot order on page 48.

3.

Follow the on-screen instructions.

Changing the workstation boot order
If your workstation does not restart in HP Recovery Manager, you can change the workstation boot order,
which is the order of devices listed in BIOS where the workstation looks for startup information. You can
change the selection to an optical drive or a USB flash drive.
To change the boot order:
1.

Insert the HP Recovery media.

2.

Access BIOS.
Restart the workstation, quickly press esc, and then press f9 for boot options.

3.

Select the optical drive or USB flash drive from which you want to boot.

4.

Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)
HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.
IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition,
create HP Recovery media; see Creating HP Recovery media (select products only) on page 45.
NOTE: The Remove Recovery Partition option is only available on products that support this function.
Follow these steps to remove the HP Recovery partition:
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1.

Type recovery in the taskbar search box, and then select HP Recovery Manager.

2.

Select Remove Recovery Partition, and then follow the on-screen instructions.
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Setting up and restoring Linux
HP offers a variety of Linux solutions for HP workstation customers:
●

HP certifies and supports Red Hat® Enterprise Linux (RHEL) on HP workstations.

●

HP certifies and supports SUSE Linux Enterprise Desktop (SLED) on HP workstations.

●

HP certifies and supports Canonical Ubuntu on HP Workstations.

●

HP offers a SLED 11 preload on some Z series Workstations.

●

HP offers an Ubuntu preload on some Z series Workstations.

This chapter describes how to set up and restore the Linux operating system. It includes these topics:
●

HP Installer Kit for Linux (HPIKL)

●

Setting up Red Hat Enterprise Linux

●

Setting up SUSE Linux Enterprise Desktop (SLED)

●

Setting up Ubuntu

●

Proprietary graphics drivers

NOTE: After you set up the operating system, be sure that the latest BIOS, drivers, and software updates
are installed. See Updating the workstation on page 55.
CAUTION: Do not add optional hardware or third-party devices to the workstation until the operating
system is successfully installed. Adding hardware might cause errors and prevent the operating system from
installing correctly.
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HP Installer Kit for Linux (HPIKL)
The HP Installer Kit for Linux helps users install certified versions of RHEL, SLED, or Ubuntu on HP
workstations. It is available as an operating system option on all HP workstations.
●

The kit contains tested drivers that augment and/or replace those found in RHEL, SLED, or Ubuntu, to
enable proper use and behavior on HP workstations.

●

The kit does not include the Linux operating system, which the user must supply. Commercial Linux
distributions are available for purchase from vendors such as Red Hat and SUSE. A variety of other Linux
distributions are available for free (e.g., Ubuntu). To view supported configurations and operating
systems, go to http://www.hp.com/support/linux_hardware_matrix.

The HPIKL option may include a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution or who have a licensed version of RHEL, SLED, or Ubuntu and would like
to install the HP-recommended driver additions.
The kit also can be downloaded using the following steps:
1.

Go to http://www.hp.com/support/workstation_swdrivers.

2.

Select your workstation model.

3.

Select the desired operating system.

4.

Select your software/driver language, and then click the Software quick jump link.

5.

Select the Obtain Software link for the appropriate package (typically the most recent revision).

6.

Click I Accept to accept the terms of the license agreement.

7.

Download the software ISO image and save it on a disc. This disk is your HP driver disc.

Setting up Red Hat Enterprise Linux
HP Z series Workstations are certified and supported on RHEL streams appropriate to the hardware
technology.
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●

For details of RHEL support for a particular platform, see the Linux Hardware Matrix for HP Workstations
at http://www.hp.com/support/linux_hardware_matrix.

●

For information about Red Hat certifications on HP workstations, go to https://hardware.redhat.com.
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HPIKL driver disc
Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver disc, which can be used as a
post-installation utility for the standard Red Hat Linux install.
After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs. After
you specify a number of settings (such as the security level, time and date, ‘root’ password, and user
accounts), the utility lets you load an additional disc.
The driver disc is used during this phase. All content added by HP is in the /HP directory on the disc. You can
use it to build your own image or to browse the HP content.
Please see /HP directory on the disk for any last-minute README pointers for elements on the disk.
NOTE: Some installations may encounter problems if they are performed with a DisplayPort connection to
the monitor. This is because the default drivers that the OS installers use do not support DisplayPort
functionality. If you experience problems, try overriding the monitor choice for DisplayPort during the start of
the install and using the VESA driver instead. You can then set up the DisplayPort monitor later.

Installing with the HP Red Hat Linux driver disc
1.

If you do not have the appropriate HP driver disc for a supported stream, create one (see HP Installer Kit
for Linux (HPIKL) on page 50.)

2.

Install the operating system using the optical media included in the Red Hat Linux box-set.

3.

If you have a Red Hat driver disk for the OS version you are installing, enter linux dd when the initial
install splash screen appears, and then press Enter.

4.

When asked if you have a driver disc, select Yes. Place the Red Hat driver disc in the drive, and select the
appropriate drive:hd[abcd]. Continue the normal installation.

5.

After successfully installing the operating system, reboot the workstation.
●

RHEL 6 or RHEL 7: Insert your HP driver disc. The HPIKL installation software automatically starts.
Follow the on-screen instructions to install the contents.

Setting up Red Hat Enterprise Linux
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Setting up SUSE Linux Enterprise Desktop (SLED)
HP offers a 64-bit SLED 11 preload on some Z series Workstations and supports 64-bit SLED 11 on other
workstations.
Various versions of SLED are certified and supported by SUSE on HP workstations. For more information, go
to the SUSE certification bulletin search page at https://www.suse.com/yessearch/Search.jsp.

Setting up preloaded SLED
To set up SLED on systems preloaded with the operating system:
1.

Start the workstation.

2.

When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.
NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration screen.
To view the full SUSE Customer Center documentation, go to http://www.suse.com/documentation, and
select your operating system.

Installing SLED with the DVD Installer Kit
1.

If an HP driver disc did not come with your workstation, create one (see HP Installer Kit for Linux (HPIKL)
on page 50).

2.

Install the operating system using the discs included in the SUSE box-set.

3.

After successfully installing the operating system, reboot the workstation.

4.

Insert your HP driver disc. The HPIKL installation software automatically starts. Follow the on-screen
instructions to install the contents.

Restoring SLED (preloaded systems only)
To restore SLED, you must use the SLED restore media. To create restore media:
1.

Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all ISO images used
to preload your workstation.

2.

Follow the instructions in the readme file in this folder to copy the ISO image file onto optical media.

3.

Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO
recovery images to restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the method and
media of your choice.
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Setting up Ubuntu
HP offers a 64-bit Ubuntu 14.04 LTS preload on some Z series Workstations and supports 64-bit Ubuntu
14.04 on other workstations.
Various versions of Ubuntu are certified and supported by Canonical on HP workstations. For more
information, go to the Ubuntu Desktop certified hardware search page at http://www.ubuntu.com/
certification/desktop/make/HP/?category=Desktop and filter the list using the word “Workstation”.

Setting up preloaded Ubuntu
To set up Ubuntu on systems preloaded with the operating system:
1.

Start the workstation.
The system boots and performs some setup activities in a non-interactive mode.
The system then reboots and plays a short video. After the video, an initial set of settings dialogs are
presented.

2.

When prompted, enter the desired language and keyboard settings, time zone, first user name and
identity, and the user password.
NOTE: This initial user has privileges to become system administrator using the sudo command. There
is no user root in the typical Ubuntu installation.
After completion of the setup, the login screen appears.

3.

Type the login information in the fields.

Using the HP Installer Kit Driver Disk
Ubuntu does not require registration to obtain software package updates. Updates can be obtained from
various “repositories” on the web using a variety of tools built into the OS. An internet connection and proxy
are all that may be required.
The HP Installer Kit for Linux driver disk for Ubuntu relies on the same mechanisms in order to satisfy
dependencies during installation. So the same internet access is needed, as well as capability to elevate from
the current user session to administrator privileges.
In some cases, HP-tested proprietary graphics drivers may be the only “payload” delivered by the driver disk.
1.

Install the operating system from your own installation media.
Ubuntu is available at no cost from www.ubuntu.com.

2.

Restart the workstation.

3.

Insert your HP driver disc. The HPIKL installation software automatically starts.

4.

When prompted for the administrator password, type the password in the field.

5.

Follow the onscreen instructions to install the drivers appropriate to your hardware configuration.

Restoring Ubuntu (preloaded systems only)
There are several methods available for restoration of the initial factory image. All assume the installed
image is in a functional state (at least initially).

Setting up Ubuntu
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CAUTION: System image restoration involves repartitioning and rewriting the image. Applications and
drivers will have to be reinstalled afterwards. The F11 and boot-loader methods described below offer you
the option to have your /home data saved across the restoration. Data and configuration information in other
file trees (such as /etc) are not preserved.
Restoring the operating system does not restore data. Back up your data using the method and media of
your choice.

Create a restore disk or drive key
The initial image includes a tool that can create a restore image as an ISO file, which can then be burned to a
bootable DVD or copied to a USB drive key. Taking this action is advisable to have media to use should the
boot drive need to be replaced.
To create the ISO:
1.

Log in and go to the DASH interface that helps you find applications.

2.

Type recovery in the field and choose recovery-media-creator.
The application starts and prompts you for the password to grant administrator privileges. It also asks
where to write the ISO file.

3.

After ISO creation is complete, copy or burn the ISO to your desired medium.

Use the F11 function key during system boot
While the system BIOS is initially booting, the F11 key can be pressed to go into a restoration process for the
hard drive image.

Intercept the boot loader and choose the restore option
When the system boot has proceeded past the BIOS prompts, a purple border appears on the screen for a
short time. If the OS boot loader is interrupted at this point using the Esc key, you should be presented with a
short menu including a restore option.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive verification by
HP. See the Linux Hardware Matrix for HP Workstations at http://www.hp.com/support/
linux_hardware_matrix for a list of supported cards.
NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for cards that
consume large amounts of power in lower-power workstations.
Third-party proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED 11 and Ubuntu preloads on Z series Workstations, and from HP
Workstation Support at http://www.hp.com/go/workstationsupport.
These proprietary drivers are not a standard part of the RHEL, SLED, or Ubuntu distributions because they are
not open source. Driver revisions more recent than those at the HP support website are supported directly by
the vendor.
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Updating the workstation
●

Updating the workstation after first boot

●

Updating the BIOS

●

Upgrading device drivers

HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, follow these guidelines to be sure that the
workstation is up-to-date:
●

Be sure that you have the latest system BIOS version loaded. See Updating the BIOS on page 55.

●

Be sure that you have the latest drivers for your system. See Upgrading device drivers on page 56.

●

Become familiar with your available HP resources.

●

Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Updating the BIOS
For optimum performance, determine the BIOS version on the workstation, and upgrade it if necessary.

Determining the current BIOS version
To determine the current BIOS version:
1.

Press Esc during startup (boot).

2.

Press F10 to enter Computer Setup (F10).

3.

Select File > System Information. Note the workstation BIOS version.
NOTE: For procedures for upgrading the BIOS as well as the Computer Setup (F10) BIOS Menu settings,
see the Maintenance and Service Guide at http://www.hp.com/support/workstation_manuals.

Updating the workstation after first boot
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Upgrading BIOS
To find and download the latest available BIOS version, which includes the latest enhancements:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

In the Download options tab, select drivers, software & firmware.

3.

Follow the instructions to locate the latest BIOS version available for the workstation.

4.

Compare the BIOS version on your workstation to the BIOS versions on the website (see Determining the
current BIOS version on page 55). If the BIOS version on the website is the same as the version on your
system, no further action is required.

5.

If the BIOS version on the website is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm that you
have the latest device drivers loaded. If you purchased your device through HP, go to the HP website to
download the latest drivers for your device. These drivers have been tested to ensure the best compatibility
between your device and your HP workstation.
If you did not purchase your device from HP, HP recommends that you go to the HP website first to see if your
device and its drivers have been tested for HP workstation compatibility. If no driver is available, go to the
device manufacturer's website to download the latest drivers.
To upgrade device drivers:
1.

Go to http://www.hp.com/go/workstationsupport and specify your product.

2.

Follow the instructions to find the latest drivers available for the workstation.

If a required driver is not found, see the website of the manufacturer of the peripheral device.
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Diagnostics and minor troubleshooting

Calling support
At times you might encounter an issue that requires support. Before you call support:
●

Have the workstation readily accessible.

●

Write down the workstation serial numbers, product numbers, model names, and model numbers and
have them in front of you.

●

Note any applicable error messages.

●

Note any add-on options.

●

Note the operating system.

●

Note any third-party hardware or software.

●

Note the details of any blinking lights on the front of the workstation (tower and desktop
configurations) or on the side of the workstation (all-in-one configurations).

●

Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example:
PS988AV) of the workstation. If the workstation has a product number, it is generally located next to the 10or 12-digit serial number of the workstation.
NOTE: The serial number and product number labels can be found on a pull-out card at the side of the
display.
For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your region,
and then, in the upper-right corner, select Connect with HP.

Calling support
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Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each workstation.
●

All workstations have a serial number (unique for each workstation) and product number. Have these
numbers available when you contact support.

●

The Certificate of Authentication (COA) is used only for systems with Windows 7 preinstalled.

●

The Genuine Microsoft Label (GML) is used only for systems with Windows 8 preinstalled.

●

A service label shows the build ID and Feature Byte strings, which are needed for system board
replacement.

The all-in-one service label can be found in the location shown in the figure below (pull-out card).
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Locating warranty information
To locate base warranty information, go to http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, go to http://www.hp.com/go/lookuptool.
To extend a standard product warranty, go to http://www.hp.com/hps/carepack. HP Care Pack Services offer
upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools
This section provides information to guide you in troubleshooting your system.

Online support
Online support resources include web-based troubleshooting tools, technical knowledge databases, driver
and patch downloads, online communities, and product change notification services.
The following websites are also available to you:
●

http://www.hp.com—Provides useful product information.

●

http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

●

http://www.hp.com/go/workstationsupport—Provides technical support information for workstations.

●

http://www8.hp.com/us/en/contact-hp/phone-assist.html—Provides a listing of the worldwide
technical support telephone numbers. Select your region.

●

http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

HP Support Center
To help you troubleshoot problems yourself, HP provides the HP Support Center. The HP Support Center is a
portal to an extensive selection of online tools. To access the HP Support Center, complete the following
steps:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Search for your product.

3.

In the Top issues & solutions tab, under Other solution options, select Troubleshoot a problem.

4.

Select the problem that you are troubleshooting.

HP Chat Support
HP Chat Support is a set of web-based support tools that automate and speed up the resolution of problems
concerning desktop computing, tape storage, and printing.
HP Chat Support enables you to electronically submit a support ticket to HP over the web. When you submit a
support ticket, HP Chat Support collects information about the workstation and passes it to an online support
specialist. The collection of information might take up to 30 seconds, depending on the workstation
configuration. When you submit a support ticket, you receive a confirmation message containing your case
ID, the support hours for your location, and the estimated time of response.
For more information about HP Chat Support, go to http://instantsupport.hp.com/.
NOTE: This feature is not available for Linux.

Locating warranty information
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Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:
1.

Go to http://www.hp.com/go/workstationsupport.

2.

Search for your product.

3.

In the Top issues & solutions tab, under Other solution options, select Advisories, bulletins & notices.

4.

Select an item for viewing.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a 30- to
60-day window of the effective date of the change in the manufacturing process. PCNs give customers
advance notice of changes to their product, such as an updated BIOS version that they might need to decide
whether to download prior to the change taking place. To view a list of PCNs, go to the Advisories, Bulletins
& Notices page for your product.
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Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following general suggestions
might help you isolate and focus on the problem before taking further action.

At startup
●

Verify that the workstation is plugged into a functional AC outlet.

●

Remove all optical discs and USB flash drives before starting the workstation.

●

Verify that the workstation is on and the power light is on.

●

If you have installed an operating system other than the factory-installed operating system, confirm
that it is supported on your system by going to http://www.hp.com/go/quickspecs.

●

Verify that the internal display panel is lit.

●

If the internal display panel is dim, turn up the brightness.

●

If you have an external monitor:
◦

Verify that the monitor is plugged into a functional AC outlet.

◦

Verify that the monitor is on and the green monitor light is on.

◦

If the monitor is dim, turn up the brightness and contrast controls.

During operation
●

Beeps and blinking lights on the workstation are error codes that can help you diagnose problems. For
more information on interpreting these codes, see the Diagnostic LED and audible (beep) codes section
in the Maintenance and Service Guide for your workstation.

●

Press and hold any key. If the system beeps, your keyboard is operating correctly.

●

Check all cables for loose or incorrect connections.

●

Wake the workstation by pressing the power button or any key on the keyboard. If the system remains
in suspend mode, shut down the system by pressing and holding the power button for at least four
seconds. Then press the power button again to restart the system.
If the system does not shut down, unplug the power cord, wait a few seconds, and then plug it in again.
If the system does not restart, press the power button.

●

After installing a non-PnP expansion board or other option (such as a diskette drive), restart the
workstation.

●

Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

●

If you are working on a network, use another cable to plug your workstation into the network
connection. If you still cannot connect, there might be a problem with the network plug.

●

If you recently added new hardware, remove the hardware to see whether the workstation functions
properly.

●

If you recently installed new software, uninstall the software to see whether the workstation functions
properly.

●

If the internal display panel on an all-in-one workstation is blank, open the workstation and be sure that
both ends of the cable between the system board and the internal display panel are connected. If you
are using a graphics card, verify that the card is properly installed.

HP troubleshooting resources and tools
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●

Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or
fixes your problem.

●

For more detailed information, see the troubleshooting chapter in the Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

Customer Self Repair
Under the Customer Self Repair programs, you can order a replacement part and install the part without onsite HP technical assistance. Customer Self Repair might be required for some components. For more
information, go to http://www.hp.com/go/selfrepair and select your product.
NOTE: Some components are not eligible for Customer Self Repair and must be returned to HP for service.
Call support for further instructions before attempting to remove or repair these components.

More troubleshooting options
The following additional information about troubleshooting techniques and tools is provided in the
Maintenance and Service Guide at http://www.hp.com/support/workstation_manuals:
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●

POST Error Codes.

●

Diagnostic lights and audible (beep) codes.

●

Troubleshooting scenarios and solutions.

●

HP PC Hardware Diagnostics (UEFI) — A set of diagnostic tests that helps determine whether the
hardware is functioning properly.
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10 Routine Care
The cleaning methods listed below are applicable to both the touch and the non-touch models of the HP Z1
G2 Workstation.

General cleaning safety precautions
●

Never use solvents or flammable solutions to clean the workstation.

●

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the workstation.

●

Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

●

Always disconnect the keyboard before cleaning it.

●

Wear safety glasses equipped with side shields when using compressed air, to prevent dust and debris
from getting into your eyes.

Cleaning products
Use the following products to safely clean your workstation:
●

Dimethyl benzyl ammonium chloride 0.3 percent maximum concentration, usually in the form of
disposable wipes in a variety of brand names

●

Alcohol-free glass cleaning fluid

●

Water with mild soap solution

●

Dry microfiber cleaning cloth or a chamois (static-free cloth without oil)

●

Static-free cloth wipes
CAUTION: Avoid strong cleaning solvents that can permanently damage your workstation. If you are
not sure if a cleaning product is safe for your workstation, check the product contents to be sure that
ingredients such as alcohol, acetone, ammonium chloride, methylene chloride, and hydrocarbons are
not included.

●

Fibrous materials, such as paper towels, can scratch the workstation. Over time, dirt particles and
cleaning agents can get trapped in the scratches.

General cleaning safety precautions

63

Cleaning the chassis
●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the workstation.

●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a soft microfiber cloth or chamois moistened with mild dish washing liquid
diluted with water. Rinse well by wiping the surface with a cloth or swab dampened with clear water.

●

After cleaning, always wipe the workstation with a clean, lint-free cloth.

●

Occasionally, clean the air vents on the workstation. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard
●

If the keyboard has an on/off switch, turn it off.

●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the keyboard.

●

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

●

Canned, pressurized air can be used to clean debris from under the keys. Use caution because too much
air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key remover to prevent damage to the keys. This tool is
available from many electronic supply outlets.
CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys are
improperly removed or installed, the keyboard might not function properly.

●

Clean under a key with a swab moistened with one of the products mentioned in Cleaning products
on page 63 of this guide. Be careful not to wipe away lubricants necessary for proper key functions.
Allow the parts to air dry before reassembly.

●

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the monitor.

●

Gently wipe the display using a soft, lint-free cloth moistened with water or an alcohol-free glass
cleaner.
CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.
Never use solvents or flammable liquids on the monitor because display or housing damage may result.
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Cleaning the mouse
1.

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the mouse.

2.

If the mouse has an on/off switch, turn it off.

3.

Wipe the body of the mouse with a soft microfiber cloth or chamois moistened with alcohol-free glass
cleaning fluid or water with mild soap solution.

4.

Note these guidelines:
●

Laser or light: use a cotton swab dampened with cleaning solution to gently brush out any dust
around the laser or light, and then wipe again with a dry swab. Do not wipe the laser or light
directly with the swab.

●

Scroll wheel: spray canned, pressurized air into the gap between the scroll wheel and the click
buttons. To avoid condensation, do not blow air directly on one spot for an extended period.

●

Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out the
socket with a dry cloth, and reassemble the mouse.

Cleaning the mouse
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11 Accessibility
HP designs, produces, and markets products and services that can be used by everyone, including people
with disabilities, either on a stand-alone basis or with appropriate assistive devices.

Supported assistive technologies
HP products support a wide variety of operating system assistive technologies and can be configured to work
with additional assistive technologies. Use the Search feature on your device to locate more information
about assistive features.
NOTE: For additional information about a particular assistive technology product, contact customer
support for that product.

Contacting support
We are constantly refining the accessibility of our products and services and welcome feedback from users. If
you have an issue with a product or would like to tell us about accessibility features that have helped you,
please contact us at (888) 259-5707, Monday through Friday, 6 a.m. to 9 p.m. Mountain Time. If you are deaf
or hard-of-hearing and use TRS/VRS/WebCapTel, contact us if you require technical support or have
accessibility questions by calling (877) 656-7058, Monday through Friday, 6 a.m. to 9 p.m. Mountain Time.
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